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									About PDF Files

Source: WebAIM

Before discussing the accessibility of PDF files, it is important to distinguish between Adobe, Acrobat and PDF. These terms are often used interchangeably, but they are not the same.

	Adobe – is a company; they are the creators of Acrobat.
	Acrobat is a tool for creating, editing and viewing PDF files.
	PDF is a format or type of document. It stands for Portable Document Format. The PDF format was created by Adobe.


The terms Adobe, Acrobat, and PDF are related in the same way as Microsoft, Word, and doc.

Note: Adobe Reader is a free utility that allows you to read and save, but not edit, PDF files. Read more about Adobe Reader and Accessibility.

You can create an accessible PDF in a few ways ways: You can scan a hardcopy document or convert an existing file from a software such as PowerPoint or Word.

Get the Software

We recommend using Adobe Acrobat Pro DC. TCU faculty/staff can install Adobe Creative Cloud software onto both TCU-owned computers and personal-owned computers.



Accessible PDFs

Source: WebAIM

PDF files are not typically created in Acrobat. They are usually created in another program and converted to PDF. There are dozens or probably hundreds of programs that can create PDF files, but very few of them produce tagged PDF files. If you are using Microsoft Word or PowerPoint, OpenOffice.org Writer, or Adobe tools such as InDesign, you can often create accessible, tagged PDF files without opening Acrobat. Of course, the accessibility of the PDF depends on the accessibility of the original document.

Start with an Accessible Document

Source: Adobe Accessibility Overview



The PDF format is a destination file format. PDF files are typically created in some other application. Optimally document accessibility should begin in the native document format. For example, many documents are created in a word processing or desktop publishing application, and then exported as PDF documents. There many things that can be done in native document applications to support accessibility, such as adding alternative text for images; defining structural headings, lists, and data tables; providing document language; and setting document properties such as titles. To gain assistance on adding accessibility into Microsoft Word documents prior to conversion to PDF format please visit our Microsoft Word or Microsoft PowerPoint pages. Making the native document accessible allows for less work when changes are made to the native document and the PDF document is regenerated.

If the native document is not available, in most cases, the document can still be made fully accessible. Without accessibility in the native format there will likely be more manual work required in the PDF to properly tag the document. There are some items such as choosing sufficient contrast between foreground and background colors that must be implemented in the native document.

Note: The ability to create accessible PDFs in Microsoft Word on a Mac began with version 2016. If you have an earlier version, we recommend you contact TCU IT for a software update, or open your files on a PC for pdf conversion.

 


Characteristics of Accessible PDF files

Source: Adobe Accessibility Overview

Accessible PDFs include but are not limited to the following characteristics:

	Searchable text: A document that consists of scanned images of text is inherently inaccessible because the content of the document is a graphic representing the letters on the page, not searchable text. Assistive technology software cannot read or extract the words in a graphical representation. Furthermore, users cannot select or edit the text or manipulate the PDF for accessibility. Scanned images of text must be converted into to searchable text using optical character recognition (OCR) before addressing accessibility in the document.
	Fonts that allow Characters to be Extracted to Text: The fonts in an accessible PDF must contain enough information for Acrobat to correctly extract all of the characters to text for purposes other than displaying text on the screen. Acrobat extracts characters to Unicode text when you read a PDF with a screen reader or the Read Out Loud tool, or when you save as text for a Braille embosser. This extraction fails if Acrobat cannot determine how to map the font to Unicode characters.
	Interactive Labeled Form Fields with Accessible Error Messages and No Timing: Some PDFs contain interactive forms that people fill out using a computer. To be accessible, form fields must be interactive; that is, a user must be able to enter values into the form fields. Interactive PDF forms also have a defined tab order which allows users of assistive technology to use the Tab key in order to progress from one form field or interactive control to the next in a logical manner. Refer to the document Adobe® Acrobat® Pro DC Accessibility Guide: Creating Accessible Forms for complete details. Forms must provide identification, give tips on proper completion, and prevent errors. Form entry should not be timed unless the user can request more time.
	Other Interactive Features: Hyperlinks and Navigational Aids: Navigational aids in a PDF — such as links, bookmarks, headings, a table of contents, and a preset tab order for form fields — assist all users in using the document without having to read through the entire document, word by word. Bookmarks are especially useful and can be created from document headings. These features can be accessed using the keyboard without relying on the mouse, and allow for multiple way for users to navigation content.
	Document Language and Title Indication: Specifying the document language in a PDF enables some screen readers to switch the current speech synthesizer to the appropriate language, allowing correct pronunciation of content in different languages. Providing a document title allows the user to locate and identify the document.
	Security that will not Interfere with Assistive Technology: Some authors of PDFs restrict users from printing, copying, extracting, editing or adding comments to text. The text of an accessible PDF must be available to a screen reader. Acrobat’s security settings can be set to protect document content while not interfering with a screen reader’s ability to convert the on-screen text to speech or Braille.
	Document Structure Tags and Proper Reading Order: To read a document’s text and present it in a way that makes sense to the user, a screen reader or other text-to-speech tool requires that the document be structured. Document structure tags in a PDF define the reading order and identify headings, paragraphs, sections, tables and other page elements. The tags structure also allows for documents to be resized and reflowed for viewing at larger sizes and on mobile devices.
	Alternative Text Descriptions for Non-Text Elements: Document features such as images and interactive form fields cannot be understood by the user of a screen reader unless they have associated alternative text. Though link text is available to screen reader users, it is possible to provide more meaningful descriptions via replacement (actual) text. Alternative text for images and tooltips can aid many users, including those with learning disabilities. Equivalents for multimedia, including any audio and video elements, must also be present.
	Other Accessible Document Characteristics: There are additional characteristics of accessible documents including:
	No reliance on color or sensory characteristics alone to convey meaning
	Use of color combinations that provides a sufficient degree of contrast
	Controls for audio
	Use of text instead of images of text
	No focus changes without user initiation
	Consistent navigation and identification of elements





 





Scanning to PDF

Instructions for scanning documents to PDF vary based on the equipment you are using. The key is to make sure that the document scans with Optical Character Recognition (OCR). This won’t scan the document as an image, but rather as text that you can copy/paste/edit and can be read by a screen reader.

Note: If your TCU copier has different options than the steps listed below, please reach out to TCU IT for assistance with scanning with your specific copier.

If you are using a Xerox copier/scanner on campus, you can try the steps below:

	Select Email from the screen.
	Type in your email address as the recipient.
	Optional: Select 2-sided scanning
	Select the document name – enter in a document name that will be more descriptive than “Doc.” Click OK.
	Click Advanced Settings.
	Select Resolution. Set the resolution to 300 dpi. Click OK.
	Select Filing Options. Click File Format.
	Select PDF then at the bottom of the screen where it says “image only” select the menu then click Searchable. Click OK.
	Click Start button on the Xerox machine. The document will scan.
	Gather your materials and go to a computer. Check your email and open the file that you emailed to yourself.


This video shows similar steps (however we do not have the USB option described in the video).

Once your file is scanned, be sure to follow the Adobe Acrobat Pro DC Accessibility Guide: PDF Accessibility Repair Workflow steps to ensure your document is accessible.



Using Adobe Acrobat DC Pro to make your PDF accessible

If your PDF isn’t accessible and you don’t have access to the source file, you can make it accessible using Adobe Acrobat DC Pro. Contact TCU IT for information about how to install Adobe Acrobat Pro.

Setup your Software

Before using Adobe Acrobat DC Pro to check accessibility of a PDF, you need to setup your software. Follow these steps below to get started.

	In the Tools tab, Select Add then Add Shortcut for the following:
	Action Wizard


	Accessibility





	Open this example PDF document (Opening a pdf document is necessary to do first to reveal the next navigation options. This document will also be needed for step 3). Select the View menu, then select  Show/Hide > Navigation Panes. Select the following (Note: for each, you will need to select View>Show/Hide>Navigation Panes)




	Tags Panel
	Content Panel
	Order Panel
	Set up the Table Editor:  Open the Tag Tree from the left side of the screen. Expand the tags until you find the Table Tag.


	Right click on the Table tag and select the Table Editor.


	The table within the document will become highlighted. Right click on the table and select Table Editor Options.


	Set the display options:




	Set your border color preferences – this is how the editor will display to you within Acrobat. Leaving default colors is fine.
	Check the boxes for:
	Show cells that span multiple rows
	Show cells with missing header
	Show cell type (TH or TD)



	The table in the document should now display with colored cells and the Table Header (TH) or Table Data (TD). This will be used later when you are reviewing your tables for proper tagging.




Once the software is setup, follow the Adobe Acrobat Pro DC Accessibility Guide: PDF Accessibility Repair Workflow steps to make your PDF accessible.



Make your PDF Accessible

Source: Adobe Accessibility Overview

The Adobe Acrobat Pro DC Accessibility Guide: PDF Accessibility Repair Workflow provides a step-by-step method for analyzing existing PDF files and making them accessible based upon that analysis. This workflow coincides with the workflow provided in the Make Accessible Action wizard and potential issues tested for in the Accessibility Checker tool.



Using the Accessibility Checker in Acrobat Pro DC

Source: Adobe Accessibility Overview

The Adobe Acrobat Pro DC Accessibility Guide: Using the Accessibility Checker describes the PDF accessibility checkers that are included in Adobe Acrobat Pro DC. Even if you generate an accessible PDF file from an authoring application such a word processor or desktop publishing program, you should then follow the steps in this guide in order to identify any items that may have been missed in the initial conversion, or to add PDF accessibility features that were not provided by the authoring tool.



Creating Accessible PDF Forms with Acrobat Pro DC

Source: Adobe Accessibility Overview

The guide entitled Adobe Acrobat Pro DC Accessibility Guide: Creating Accessible Forms describes how to use the forms tools within Adobe Acrobat Pro DC to add descriptions to form fields, tag untagged forms, set the tab order, manipulate tags and perform other PDF accessibility tasks. These techniques do not apply to PDF forms from Adobe LiveCycle Designer, as a separate process is provided for making LiveCycle forms accessible.



File Name

If you upload files to TCU Online, so they appear as content within a module, be sure to update the title of the file so that it is descriptive within the module. Avoid having ENG10803.030sp18syll as a file title that would appear in the module. Instead use “Syllabus” or “Spring 2018 Syllabus.”



Additional Resources

	Accessibility Checklists: PDF File 508 Checklist
	Acrobat and Accessibility – review WebAim’s resources


																 

								
									
								 

								



	
	
	

	



							 

							
						
 

										

					
						Accessibility
	Creating Accessible Course Content




					
				

				
 

			
 

			

				
					
						Contact:
			Sadler Hall, Third Floor

TCU Box 298970

Fort Worth, TX 76129

Phone: (817) 257-7434

Email: KoehlerCenter@tcu.edu
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